
EXCAVATION IN SAND

2 EXCAVATION IN SAND

This tutorial describes the construction of an excavation pit in soft clay and sand layers.
The pit is a relatively small excavation of 12 by 20 m, excavated to a depth of 6.5 m
below the surface. Struts, walings and ground anchors are used to prevent the pit from
collapsing. After the full excavation, an additional surface load is added on one side of
the pit.
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Figure 2.1 Top view of the excavation pit

The proposed geometry for this exercise is 80 m wide and 50 m long, as shown in Figure
2.1. The excavation pit is placed in the center of the geometry. Figure 2.2 shows a cross
section of the excavation pit with the soil layers. The clay layer is considered to be
impermeable.

Objectives:

• Using the Hardening Soil model

• Modelling of ground anchors

• Using interface features

• Defining over-consolidation ratio (OCR)

• Prestressing a ground anchor

• Changing water conditions

• Selection of stress points to generate stress/strain curves

• Viewing plastic points
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Figure 2.2 Cross section of the excavation pit with the soil layers

2.1 GEOMETRY

To create the geometry model, follow these steps:

Project properties

• Start a new project.

• Enter an appropriate title for the project.

• Define the limits for the soil contour as xmin = 0, xmax = 80, ymin = 0 and ymax = 50.

2.1.1 DEFINITION OF SOIL STRATIGRAPHY

In order to define the soil layers, a borehole needs to be added and material properties
must be assigned. As all soil layers are horizontal, only a single borehole is needed.

Create a borehole at (0 0 0). The Modify soil layers window pops up.

• Add 4 layers with bottom levels at -1, -9.5, -11, -20. Set the Head in the borehole
column to -4 m.

Open the Material sets window.

• Create a new data set under Soil and interfaces set type.

• Identify the new data set as "Fill".

• From the Material model drop-down menu, select Hardening Soil model. In contrast
with the Mohr-Coulomb model, the Hardening Soil model takes into account the
difference in stiffness between virgin-loading and unloading-reloading. For a
detailed description of the Hardening Soil model, see the Chapter 6 in the Material
Models Manual.

• Define the saturated and unsaturated unit weights according to Table 2.1.

• In the Parameters tabsheet, enter values for E ref
50 , E ref

oed , E ref
ur , m, c'ref , ϕ'ref , ψ and

ν 'ur according to Table 2.1. Note that Poisson's ratio is an advanced parameter.

• As no consolidation will be considered in this exercise, the permeability of the soil
will not influence the results. Therefore, the default values can be kept in the Flow
parameters tabsheet.
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Table 2.1 Material properties for the soil layers

Parameter Name Fill Sand Soft Clay Unit

General

Material model Model Hardening Soil
model

Hardening Soil
model

Hardening Soil
model

−

Drainage type Type Drained Drained Undrained A −
Unit weight above phreatic level γunsat 16.0 17.0 16.0 kN/m3

Unit weight below phreatic level γsat 20.0 20.0 17.0 kN/m3

Parameters

Secant stiffness for CD triaxial
test

E ref
50 2.2 · 104 4.3 · 104 2.0 · 103 kN/m2

Tangent oedometer stiffness E ref
oed 2.2 · 104 2.2 · 104 2.0 · 103 kN/m2

Unloading/reloading stiffness E ref
ur 6.6 · 104 1.29 · 105 1.0 · 104 kN/m2

Power for stress level
dependency of stiffness

m 0.5 0.5 1.0 −

Cohesion c'ref 1 1 5 kN/m2

Friction angle ϕ' 30.0 34.0 25.0 ◦

Dilatancy angle ψ 0.0 4.0 0.0 ◦

Poisson's ratio ν 'ur 0.2 0.2 0.2 −
Interfaces

Interface strength − Manual Manual Manual −
Interface reduction factor Rinter 0.65 0.7 0.5 −
Initial

K0 determination − Automatic Automatic Automatic −
Lateral earth pressure coefficient K0 0.5000 0.4408 0.7411 −
Over-consolidation ratio OCR 1.0 1.0 1.5 −
Pre-overburden pressure POP 0.0 0.0 0.0 −

• In the Interfaces tabsheet, select Manual in the Strength box and enter a value of
0.65 for the parameter Rinter . This parameter relates the strength of the interfaces to
the strength of the soil, according to the equations:

ci = Rinter csoil and tanϕi = Rinter tanϕi ≤ tanϕsoil

Hence, using the entered Rinter -value gives a reduced interface friction and interface
cohesion (adhesion) compared to the friction angle and the cohesion in the adjacent
soil.

Hint: When the Rigid option is selected in the Strength drop-down, the interface
has the same strength properties as the soil (Rinter = 1.0).

» Note that a value of Rinter < 1.0, reduces the strength as well as the stiffness
of the interface (Section 6.1.6 of the Reference Manual).

• In the Initial tabsheet, define the OCR-value according to Table 2.1.

• Click OK to close the window.

• In the same way, define the material properties of the "Sand" and "Soft Clay"
materials as given by Table 2.1.

• After closing the Material sets window, click the OK button to close the Modify soil
layers window.

• In the Soil mode right click on the upper soil layer. In the appearing right hand
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mouse button menu, select the Fill option in the Set material menu.

• In the same way assign the Soft Clay material to the soil layer between y = -9.5 m
and y = -11.0 m.

• Assign the Sand material to the remaining two soil layers.

• Proceed to the Structures mode to define the structural elements.

Hint: The Tension cut-off option is activated by default at a value of 0 kN/m2. This
option is found in the Advanced options on the Parameters tabsheet of the
Soil window. Here the Tension cut-off value can be changed or the option
can be deactivated entirely.

2.1.2 DEFINITION OF STRUCTURAL ELEMENTS

The creation of sheet pile walls, walings, struts and surface loads and ground anchors is
described below.

Create a surface between (30 20 0), (30 32 0), (50 32 0) and (50 20 0).

Extrude the surface to z = -1, z = -6.5 and z = -11.

• Right-click on the deepest created volume (between z = 0 and z = -11) and select
the Decompose into surfaces option from the appearing menu.

• Delete the top surfaces (2 surfaces). An extra surface is created as the volume is
decomposed.

• Hide the excavation volumes (do not delete). The eye button in the Model explorer
and the Selection explorer trees can be used to hide parts of the model and simplify
the view. A hidden project entity is indicated by a closed eye.

Click the Create structure button.

Create beams (walings) around the excavation circumference at level z = −1m.
Press the Shift key and keep it pressed while moving the mouse cursor in the
-z-direction. Stop moving the mouse as the z− coordinate of the mouse cursor is
−1 in the cursor position indicator. Note that as you release the Shift key, the
z-coordinate of the cursor location does not change. This is an indication that you
can draw only on the xy-plane located at z = -1.

• Click on (30 20 -1), (30 32 -1), (50 32 -1), (50 20 -1), (30 20 -1) to draw the walings.
Click on the right mouse button to stop drawing walings.

Create a beam (strut) between (35 20 -1) and (35 32 -1). Press Esc to end defining
the strut.

Create data sets for the walings and strut according to Table 2.2 and assign the
materials accordingly.

Copy the strut into a total of three struts at x = 35 (existing), x = 40, and x = 45.
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Table 2.2 Material properties for the beams

Parameter Name Strut Waling Unit

Material type Type Elastic Elastic −
Young's modulus E 2.1 · 108 2.1 · 108 kN/m2

Unit weight γ 78.5 78.5 kN/m3

Cross section area A 0.007367 0.008682 m2

Moment of Inertia I2 5.073 · 10−5 3.66 · 10−4 m4

I3 5.073 · 10−5 1.045 · 10−4 m4

Modelling ground anchors

In PLAXIS 3D ground anchors can be modelled using the Node-to-node anchor and the
Embedded beam options as described in the following:

First the ungrouted part of the anchor is created using the Node-to-node anchor
feature. Start creating a node-to-node anchor by selecting the corresponding button
in the options displayed as you click on the Create structure button.

• Click on the command line and type "30 24 -1 21 24 -7 " . Press Enter and Esc to
create the ungrouted part of the first ground anchor.

• Create a node-to-node anchor between the points (50 24 -1) and (59 24 -7).

The grouted part of the anchor is created using the Embedded beam option. Create
embedded beams between (21 24 -7) and (18 24 -9) and between (59 24 -7) and (62
24 -9). Set the Behaviour to Grout body (Section 5.8.4 of the Reference Manual).

Create a data set for the embedded beam and a data set for the node-to-node
anchor according to Table 2.3 and Table 2.4 respectively. Assign the data sets to the
node-to-node anchors and to the embedded beams.

Table 2.3 Material properties for the node-to-node anchors

Parameter Name Node-to-node anchor Unit

Material type Type Elastic −
Axial stiffness EA 6.5·105 kN

Table 2.4 Material properties for the embedded beams (grout body)

Parameter Name Grout Unit

Young's modulus E 3 · 107 kN/m2

Unit weight γ 24 kN/m3

Beam type − Predefined −
Predefined beam type − Massive circular beam −
Diameter Diameter 0.14 m
Axial skin resistance Type Linear −
Skin resistance at the top of the
embedded beam

Tskin,start ,max 200 kN/m

Skin resistance at the bottom of the
embedded beam

Tskin,end ,max 0.0 kN/m

Base resistance Fmax 0.0 kN

Hint: The colour indicating the material set assigned to the entities in project can
be changed by clicking on the Colour box of the selected material set and
selecting a colour from the Colour part of the window.
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The remaining grouted anchors will be created by copying the defined grouted anchor.

Click on the Select button and click on all the elements composing both of the
ground anchors keeping the Ctrl key pressed.

Use the Create array function to copy both ground anchors (2 embedded beams + 2
node-to-node anchors) into a total of 4 complete ground anchors located at y = 24
and y = 28 by selection the 1D, in y direction option in the Shape drop-down menu
and define the Distance between columns as 4 m.

Multi-select all parts of the ground anchors (8 entities in total). While all parts are
selected and the Ctrl key is pressed, click the right mouse button and select the
Group from the appearing menu.

In the Model explorer tree, expand the Groups subtree by clicking on the (+) in front
of the groups.

• Click the Group_1 and rename it to "GroundAnchors".

Hint: The name of the entities in the project should not contain any space or
special character except "_" .

To define the sheet pile walls and the corresponding interfaces, follow these steps:

Select all four vertical surfaces created as the volume was decomposed. Keeping
the Ctrl key pressed, click the right mouse button and select the Create plate option
from the appearing menu.

Create a data set for the sheet pile walls (plates) according to Table 2.5. Assign the
data sets to the four walls.

• As all the surfaces are selected, assign both positive and negative interfaces to
them using the options in the right mouse button menu.

Hint: The term 'positive' or 'negative' for interfaces has no physical meaning. It
only enables distinguishing between interfaces at each side of a surface.

Table 2.5 Material properties of the sheet pile walls

Parameter Name Sheet pile wall Unit

Type of behaviour Type Elastic, non-isotropic −
Thickness d 0.379 m
Weight γ 2.55 kN/m3

Young's modulus E1 1.46 · 107 kN/m2

E2 7.3 · 105 kN/m2

Poisson's ratio ν12 0.0 −
Shear modulus G12 7.3 · 105 kN/m2

G13 1.27 · 106 kN/m2

G23 3.82 · 105 kN/m2

Non-isotropic (different stiffnesses in two directions) sheet pile walls are defined. The
local axis should point in the correct direction (which defines which is the 'stiff' or the 'soft'
direction). As the vertical direction is generally the stiffest direction in sheet pile walls,
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local axis 1 shall point in the z-direction.

In the Model explorer tree expand the Surfaces subtree, set AxisFunction to Manual
and set Axis1z to −1. Do this for all the pile wall surfaces.

Create a surface load defined by the points: (34 19 0), (41 19 0), (41 12 0), (34 12
0). The geometry is now completely defined.

Hint: The first local axis is indicated by a red arrow, the second local axis is
indicated by a green arrow and the third axis is indicated by a blue arrow.
More information related to the local axes of plates is given in the Reference
Manual.

2.2 MESH GENERATION

• Click on the Mesh tab to proceed to the Mesh mode.

• Select the surface representing the excavation. In the Selection explorer set the
value of Coarseness factor to 0.25.

Set the element distribution to Coarse. Uncheck the box for Enhanced mesh
refinements. Generate the mesh.

View the mesh. Hide the soil in the model to view the embedded beams.

• Click on the Close tab to close the Output program and go back to the Mesh mode
of the Input program.

Hint: The Enhanced mesh refinements are automatically used in mesh generation.
More information is available in Section 7.1.3 of Reference Manual.

2.3 PERFORMING CALCULATIONS

The calculation consists of 6 phases. The initial phase consists of the generation of the
initial stresses using the K0 procedure. The next phase consists of the installation of the
sheet piles and a first excavation. Then the walings and struts will be installed. In phase
3, the ground anchors will be activated and prestressed. Further excavation will be
performed in the phase after that. The last phase will be the application of the additional
load next to the pit.

• Click on the Staged construction tab to proceed with definition of the calculation
phases.

• The initial phase has already been introduced. Keep its calculation type as K0
procedure. Make sure all the soil volumes are active and all the structural elements
are inactive.

Add a new phase (Phase_1). The default values of the parameters will be used for
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this calculation phase.

• Deactivate the first excavation volume (from z = 0 to z = −1).

• In the Model explorer, activate all plates and interfaces by clicking on the checkbox
in front of them. The active elements in the project are indicated by a green check
mark in the Model explorer.

Add a new phase (Phase_2). The default values of the parameters will be used for
this calculation phase.

• In the Model explorer activate all the beams.

Add a new phase (Phase_3). The default values of the parameters will be used for
this calculation phase.

• In the Model explorer activate the GroundAnchors group.

Select one of the node-to-node anchors.

In the Selection explorer expand the node-to node anchor features.

• Click on the Adjust prestress checkbox. Enter a prestress force of 200 kN (Figure
2.3).

• Do the same for all the other node-to-node anchors.

Figure 2.3 Node-to-node anchor in the Selection explorer

Add another phase (Phase_4). The default values of the parameters will be used for
this calculation phase.

Select the soil volume to be excavated in this phase (between z = −1 and
z = −6.5).

In the Selection explorer under WaterConditions feature, click on the Conditions and
select the Dry option from the drop-down menu.

Figure 2.4 Water conditions in the Selection explorer
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• Deactivate the volume to be excavated (between z = -1 and z = -6.5).

• Hide the soil and the plates around the excavation.

Select the soil volume below the excavation (between z = -6.5 and z = -9.5).

In Selection explorer under WaterConditions feature,

• click Conditions and select Head from the drop-down menu. Enter zref = -6.5 m.

Select the soft clay volume below the excavation.

• Set the water conditions to Interpolate.

Preview this calculation phase.

Click the Vertical cross section button in the Preview window and define the cross
section by drawing a line across the excavation.

• Select the psteady option from the Stresses menu.

Hint: Hold Shift key when drawing to get a straight line.

Display the contour lines for steady pore pressure distribution. Make sure that the
Legend option is checked in View menu. The steady state pore pressure distribution
is displayed in Figure 2.5. Scroll the wheel button of the mouse to zoom in or out to
get a better view.

• Change the legend settings to:

• Scaling: manual

• Maximum value: 0

• Number of intervals: 18

Figure 2.5 Preview of the steady state pore pressures in Phase_4 in a cross section

• Click on the Close button to return to the Input program.

Add another phase (Phase_5). The default values of the parameters will be used for
this calculation phase.

• Activate the surface load and set σz = -20 kN/m2.
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Defining points for curves

Before starting the calculation process, some stress points next to the excavation pit and
loading are selected to plot a stress strain curve later on.

Click the Select points for curves button. The model and Select points window will
be displayed in the Output program.

• Define (37.5 19 -1.5) as Point-of-interest coordinates.

Hint: The visualization settings can be changed from the menu. For more
information refer Section 8.5.2 of Reference Manual .

• Click the Search closest button. The number of the closest node and stress point
will be displayed.

• Click the checkbox in front of the stress point to be selected. The selected stress
point will be shown in the list.

• Select also stress points near the coordinates (37.5 19 -5), (37.5 19 -6) and (37.5 19
-7) and close the Select points window.

• Click the Update button to close the Output program.

Start the calculation process.

Save the project when the calculation is finished.

Hint: Instead of selecting nodes or stress points for curves before starting the
calculation, points can also be selected after the calculation when viewing
the output results. However, the curves will be less accurate since only the
results of the saved calculation steps will be considered.

» To plot curves of structural forces, nodes can only be selected after the
calculation.

» Nodes or stress points can be selected by just clicking them. When moving
the mouse, the exact coordinates of the position are given in the cursor
location indicator bar at the bottom of the window.

2.4 VIEWING THE RESULTS

After the calculations, the results of the excavation can be viewed by selecting a
calculation phase from the Phases tree and pressing the View calculation results button.

Select the final calculation phase (Phase_5) and click the View calculation results
button. The Output program will open and will show the deformed mesh at the end
of the last phase.

• The stresses, deformations and three-dimensional geometry can be viewed by
selecting the desired output from the corresponding menus. For example, choose
Plastic points from the Stresses menu to investigate the plastic points in the model.
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• In the Plastic points window, Figure 2.6, select all the options except the Elastic
points and the Show only inaccurate points options. Figure 2.7 shows the plastic
points generated in the model at the end of the final calculation phase.

Figure 2.6 Plastic points window

Figure 2.7 Plastic points at the end of the final phase

The graph will now show the major principal strain against the major principal stress.
Both values are zero at the beginning of the initial conditions. After generation of the
initial conditions, the principal strain is still zero whereas the principal stress is not zero
anymore. To plot the curves of all selected stress points in one graph, follow these steps:

• Select Add curve→ From current project from right mouse button menu.

• Generate curves for the three remaining stress nodes in the same way.

The graph will now show the stress-strain curves of all four stress points (Figure 2.9). To
see information about the markers, make sure the Value indication option is selected
from the View menu and hold the mouse on a marker for a while. Information about the
coordinates in the graph, the number of the point in the graph, the number of the phase
and the number of the step is given. Especially the lower stress points show a
considerable increase in the stress when the load is applied in the last phase.

To create a stress path plot for stress node (37.5 19 -1.5) follow these steps:
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Figure 2.8 Curve generation window

Figure 2.9 Stress - Strain curve

Hint: To re-enter the Curve generation window (in the case of a mistake, a desired
regeneration or a modification), the Curve settings option from the Format
menu can be selected. As a result the Curves settings window appears, on
which the Regenerate button should be clicked.

» The Chart settings option in the Format menu may be used to modify the
settings of the chart.

• Create a new chart.

• In the Curves generation window, select node (37.5 19 -1.5) from the drop-down
menu of the x−axis of the graph and σ'yy under Cartesian effective stresses.

• Select node (37.5 19 -1.5) from the drop-down menu of the y−axis of the graph.
Select σ'zz under Cartesian effective stresses.

• Click OK to confirm the input (Figure 2.10).
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Figure 2.10 Vertical effective stress (σ'zz ) versus horizontal effective stress (σ'yy ) at stress node
located near (37.5 19 -1.5)
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